
Xerox® 4112™/4127™
Copier/Printer
PostScript® User Guide

Version 3.0
May 2009



©2009 Xerox Corporation. All rights reserved. Xerox, the sphere of connectivity design, and 
Xerox 4112/4127 Copier/Printer are trademarks of Xerox Corporation in the United States and/
or other countries. 

Microsoft, MS-DOS, Windows, Microsoft Network, and Windows Server are either trademarks or 
registered trademarks of Microsoft Corporation in the United States and/or other countries.

Novell, NetWare, IntranetWare and NDS are registered trademarks of Novell, Inc. in the United 
States and other countries.

Adobe, Acrobat, PostScript, PostScript3, and PostScript Logo are trademarks of Adobe Systems 
Incorporated.

Apple, AppleTalk, EtherTalk, LocalTalk, Macintosh, MacOS and TrueType are trademarks of Apple 
Computer, Inc., registered in the U.S. and other countries.

HP, HPGL, HPGL/2, and HP-UX are registered trademarks of Hewlett-Packard Corporation.

Changes are periodically made to this document. Changes, technical inaccuracies, and 
typographic errors will be corrected in subsequent editions.



PostScript User Guide  i

Table of Contents

1 Windows 2000/XP/Vista and Windows Server 2003 . . . . . . 1-1
About the software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-1

Bundled software  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-1
Xerox 4112/4127 PS Driver and PPD files . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-1
Adobe Acrobat Reader . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-1

Hardware/software requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-2
Computer System. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-2
Basic Software. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-2

The Xerox 4112/4127 PS Printer Driver  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-2
Installation Procedure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-3
Device options and print settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-10

Device Settings tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-10
Configuration tab. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-11
Detailed Settings tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-13
Paper/Output tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-15
Layout tab. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-20

2 Macintosh computers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-1
About the software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-1

Bundled software  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-1
AdobePS Printer Driver (ver. 8.5.1, 8.7.0, and 8.8) and PPD files  . . . . . .  2-1
Xerox PPD Installer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-1
Xerox PS Utility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-1
Adobe Screen Fonts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-1
ATM (Adobe Type Manager) (ver. 4.5.2) . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-1
Adobe Acrobat Reader . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-2
Readme.txt . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-2

Hardware/software requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-2
Computer system . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-2
Basic software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-2

AdobePS Printer Driver . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-2
Installation procedure (Mac OS X)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-3

Adding a Printer (Mac OS X) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-4
Printer options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-6

For Mac OS X . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-6
Printer features  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-7

For Mac OS X . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-7
Job Type (Mac OS X only) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-11
Job Accounting (Mac OS X only)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-13

Installing screen fonts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-15
3 Barcode Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-1

About barcode settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-1
Font types and character sets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-1
Sample program and output results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-2

Character set tables  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-2



Table of Contents Xerox 4112/4127 Copier/Printer

 ii PostScript User Guide

JAN character set table . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-2
Code 39 character set table  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-3
NW7 character set table . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-4
Code 128 character set table . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-4
ITF (Interleaved 2 of 5) character set table . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-8

Example: . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-9
Customer barcode character set table  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-9

Barcode sizes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-10
A Appendix . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-1

Cautions and limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-1
About the driver . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-1
Troubleshooting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-1
Print operation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-1



PostScript User Guide  1-1  

1Windows 2000/XP/
Vista and Windows 
Server 2003

Tip
The User Interface (UI) screens shown in this guide may or may not reflect the screens 
displayed on your 4112/4127 system. The UI screens vary from system to system and from 
marketplace to marketplace. Therefore, the UI screens in this guide are a representation of the 
type of screens that may be seen on your particular system.

About the software

Bundled software

The following items are included on the CD-ROM and are necessary when using the printer on 
Windows 2000, Windows XP, Windows Vista, and Windows Server 2003. Please read the 
“Readme.txt” file which contains cautionary notes about how to use the printer driver.

Xerox 4112/4127 PS Driver and PPD files

Xerox 4112/4127 PS Driver and PPD files (for Windows 2000, Windows XP, Windows Vista, and 
Windows Server 2003).

Adobe Acrobat Reader

Allows you to view and print PDF files on all major computing platforms.



Windows 2000/XP/Vista and Windows Server 2003 Xerox 4112/4127 Copier/Printer

1-2  PostScript User Guide

Hardware/software requirements
The minimum system requirements for the printer driver are:

Computer System

Personal computer which can run the Windows 2000, Windows XP, Windows Vista, or Windows 
Server 2003 operating system.

Basic Software
• Windows 2000 Professional
• Windows 2000 Server
• Windows 2000 Advanced Server
• Windows XP Professional Edition
• Windows XP Home Edition
• Windows Vista Home Basic/Premium Edition
• Windows Vista Business/Ultimate
• Windows Server 2003

The Xerox 4112/4127 PS Printer Driver 
Tip
When installing the printer driver, ensure that you select the correct one (4112/4127).

Install Xerox 4112/4127 PS printer driver onto Windows 2000, Windows XP, Windows Vista, and 
Windows Server 2003 by following the procedure below.

This section describes how to install the printer driver for Windows 2000, as an example.

Notes
• It is possible to cancel installation of the printer driver by clicking Cancel in the dialog box 

displayed during installation. You can also click Back to delete the settings in that dialog 
box and return to the previous dialog box.

• If you want to set up Port 9100, refer to the System Administration Guide.
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Installation Procedure
1. Start the computer.

Note
Log on as a Power User group member or an Administrator. Refer to the Windows 2000 
documentation for details about the Power User group.

2. On the Start menu, point to Settings and click Printers.
3. In the Printers window, double-click Add Printer.

4. Click Next. 

5. Select how the printer is connected to the computer and click Next. 
Select Local printer if the printer is connected directly to the computer or to the network in 
the TCP/IP(LPD) environment. Otherwise, select Network printer. The following is an 
example of a Local printer.
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Notes
• When you select Local printer, deselect the “Automatically detect and install my Plug 

and Play printer” check box.

• Specify the target printer in the Connect to printer dialog box if you selected Network 
printer.

6. Select the port you are using and click Next.

When the printer is connected in the TCP/IP(LPD) environment:

a. Click Create a new port.
b. Select Standard TCP/IP Port in the Type list and click Next.
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c. Click Next.

d. Enter the IP address of the printer in Printer Name or IP Address, then click Next. 
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e. Click Finish in the dialog box that will be displayed.
7. Insert the PostScript Driver Library CD-ROM in the CD-ROM drive. 
8. Click Have Disk. 

9. Enter “Drive Name:\PrinterDriver\Win2K_XP” in the “Copy manufacturer’s files from:” box 
and click OK.
In this example, we have used “D:” as the CD-ROM drive. If you are using a different drive 
for the CD-ROM, specify accordingly.
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Note
Click Browse to specify a folder on the CD-ROM. 

10. Select your printer model from the Printers list and click Next. 

11. Enter the printer name, set whether you want to use it as the default printer, and click Next. 
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12. Select Do not share this printer and click Next. 
We recommend that you install the driver on each computer with the procedure 
appropriate to the operating system. 

13. Specify whether or not to print a test page, then click Next. 
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14. Click Finish. 

Note
If the dialog box “Digital Signature Not Found” appears, click Yes to continue the 
installation.

Installation begins.

15. Confirm that the printer has been added in the Printers window. 

• This completes the installation of the printer driver. Remove the CD-ROM from the 
drive.

• See “Device options and print settings” to configure the printer. 

• Store your CD-ROM in a safe place.



Windows 2000/XP/Vista and Windows Server 2003 Xerox 4112/4127 Copier/Printer

1-10  PostScript User Guide

Device options and print settings

To view the Device Settings or Configuration tabs, select the printer in the Printers window, then 
click [Properties] on the File menu.

To view the Advanced Options dialog box, select the printer in the Printers window, then click 
Printing Preferences on the File menu. Click Advanced in the Layout screen. 

To view the Output Settings tab, select the printer in the Printers window, then click Printing 
Preferences on the File menu.

Device Settings tab

This section describes installable options in the Device Settings tab. To print correctly, it is 
necessary to make the appropriate settings in this tab.

Select the items in Installable Options area and change the settings in the menu that appears 
on the right.

Settings:

High Capacity Feeder

Select "Available" if the High Capacity Feeder has been installed.

Hole Punch

Specify the number of holes to punch on the paper. Select from "2 Holes/4 Holes" or "2 Holes/3 
Holes."

Tri-Folding Output Tray



Xerox 4112/4127 Copier/Printer Windows 2000/XP/Vista and Windows Server 2003

PostScript User Guide 1-11  

Select "Available" if the Tri-Fold Output Tray is installed.

Booklet Output Tray

Select "Available" if the Booklet Tray is installed.

Paper Size Settings

Specify the paper size group for different locales to enable the selection of paper sizes common 
to that locale. The following groups of paper size categorized by locale are available: "AB Series," 
"AB Series (8K / 16K)," "AB Series (8 x 13 in.)," "AB Series (8 x 13 / 8 x 14 in.)," and "Inch Series." 
As the paper size settings will be set automatically in accordance with the relevant locale, it is 
usually not necessary to change this setting.

Switch Paper Size (8K/16K)

Indicate your language preference to enable the set of 8K and 16K paper sizes that is best 
suited to your needs. If you select "Traditional Chinese," the dimensions of the 8K and 16K 
paper sizes are 267 x 388mm and 194 x 267mm respectively. If you select "Simplified Chinese," 
the dimensions will be 270 x 390mm and 195 x 270mm respectively.

Note
If "AB Series (8K/16K)" is not selected in "Paper Size Settings," both sets of 8K and 16K paper 
sizes will not be available despite the setting specified here.

Configuration tab 

Note
You can restore defaults by clicking Restore Defaults.

Settings:

Account Mode

Specifies if all users or only System Administrators can change authentication related settings.

Detailed User Settings
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• Sets the authentication information.

– Use Default User Settings - The values set in this feature are used as the 
authentication parameters.

– Specify Job Owner Name - Select how to specify User ID.

– Job Owner Name - Enter a User ID.

– Password - Enter a Password that matches the User ID.

– Account ID - Enter an Account ID.

– Billing ID - Enter a User ID for Charge Print.

– Password - Enter a Password that matches the Billing ID.

• Prompt User for Settings - Select this feature to display the Enter User Details dialog-box 
each time you start printing. The user is then required to enter authentication information 
such as their User ID.

– Display Previous User Details - Select to store the user details entered in the Enter 
User Details dialog-box, and display the details in the box as a default next time.

– Hide User ID(***) - Select to specify whether an account ID is to be displayed or hidden 
when it is entered.

– Hide Account ID(***) - Select to specify whether an account ID is to be displayed or 
hidden when it is entered.

High Speed Printing

Set this feature to make improvements in print speed, when using an application that generates 
PostScript directly.

Get Information from Printer

Clicking Get Information from Printer when the machine is used as a network printer verifies 
the printer option installation state using the print port to which the printer is connected, and 
reflects this in the Hardware Options setting.
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Detailed Settings tab

Select the items from Printer Features and change them on the menu displayed to the right. 

Settings:

Bypass Feed Orientation

Specifies the paper orientation when printing from the bypass tray. When feeding the short 
edge of the paper first, select Landscape. When feeding the long edge of the paper, select 
Portrait.

Offset Stacking

The position of individual jobs or sets of copies are shifted to either side of the output tray to 
enable easy separation.

Covers

Specifies the settings related to Covers.

Note
The cover cannot be printed.

• Front Cover - Specify whether to add a front cover to the printouts. Select the paper tray for 
feeding the front cover sheets.

• Back Cover - Specify whether to add a back cover to the printouts. Select the paper tray for 
feeding the back cover sheets.

• Tray 8 - Specify Tab Stock - Specify whether tab stock is being loaded in tray 8. Select 
either "Plain" or "Tab Stock."
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Transparencies

Set up separators to be inserted between transparencies.

• Feed Separators from - Specifies the paper tray that transparency dividers are to be fed 
from. When Auto is selected, the tray set on the machine is used as the feed destination.

• Print on Separators - Specifies whether or not to print on the transparency dividers as well 
as the transparency.

Images

Set up image-related settings.

• Print Mode - Specifies whether to give priority to the print speed or the image quality.

• Halftone - Select the halftone settings for printing.

– Select Fine Dots for the small size halftone dot commonly used in PostScript.

– Select Thick Dots for coarser dots than the Fine Dots setting.

– Select Type 3 for the same halftone setting that is used in PCL.

• Image Enhancement - Specifies whether or not to use the Image Enhancement function. 
Selecting On smooths out boundaries when printing. This reduces jagged edges by 
artificially increasing the resolution of the image. When printing a bitmapped image 
composed of coarse halftone dots, smooth color or grayscale gradation is impossible in 
certain situations. In this case, select Off.

Details

Set up other printing options.

• Image Rotation (180deg) - Set the checkbox to rotate the prints by 180°. Default is Off.

• Double Print - Enable this feature to repeatedly print one page twice on a paper with a 
bigger size than the original. You can use Double Print feature if you have set the zoom 
ratio to 100% with the following paper size and output size settings. 

• Paper Size

• Output Size

• A4

• A3

• A5

• A4

• B5

• B4

• Folio (8.5 x 11 in.)

• Ledger (11 x 17 in.)

• Skip Blank Pages - Specify whether to skip blank pages when printing documents that 
consist of blank pages.

• Draft Mode - Specifies whether or not to reduce the amount of toner used when printing 
drafts. When On is selected, the overall printed page becomes lighter. This is best for 
printing documents when high print quality is not necessary.

• Banner Sheet - Specifies whether or not to add a banner sheet to printed output.

– When Use Printer Settings is selected, the printer settings are used.
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– When Printer Start Page is selected, outputs the banner sheet using the start-sheet.

• E-mail Job Confirmation - Specifies whether or not to use the Mail Notify feature to notify 
the end of the print job via e-mail. Default is Off.

Enter Address - Specifies the e-mail address for the Mail Notify feature.

• Substitute Tray - Specifies what action to take when the paper for the print size is not 
loaded in the machine.

• Tab Margin Shift - Selecting On shifts the image by 13 mm during printing on the printer, 
and prints text on the tab portion of the tab stock. When preparing a document, place text 
on the part of the document where the tab will be located (assuming that the entire image 
will be shifted by 13 mm).

The tab is on the side of the tab stock that is output first.

• Custom Paper Auto Orientation - Specifies whether or not to correct the orientation of the 
custom paper.

• Print Mixed Size Originals - Controls the orientation of the second-side image when 
printing double-sided.

About

Click the "About" button to display the "About" dialog box. The version number and copyright 
description for this print driver will be displayed.

Help

To display Help, click the "Contents" button at the top left of the screen. You can find detailed 
descriptions on the content items in Help or enter keywords to search for needed information.

Paper/Output tab

Note
You can restore defaults by clicking Restore Defaults.



Windows 2000/XP/Vista and Windows Server 2003 Xerox 4112/4127 Copier/Printer

1-16  PostScript User Guide

Settings:

Job Type

You can select Normal Print or specify the print function for Secure Print, Sample Print, and 
Delayed Print. To use Secure Print, Sample Print, or Delayed Print feature, input the User ID and 
password for Print Type in the Configuration tab. The password entered appears as asterisks(*).

• Normal Print - Select when you do not want to output secure prints, sample prints, or 
delayed prints.

• Secure Print - Secure Print temporarily stores print jobs in the printer and then prints them 
when print instructions are received from the control panel. Select when you want to 
output secure prints.

– User ID - Displays the User ID for Job Type. The user ID displayed is the User ID 
specified on the Configuration tab. This option can only be selected when the setting 
on the Configuration tab has been completed. This is a display-only item and cannot 
be changed here.

– Password - Displays the password for Secure Print as specified in the Configuration tab. 
Each digit entered appears as an asterisk (*). This option can only be selected when the 
setting on the Configuration tab has been completed. This is a display-only item and 
cannot be changed here.

– Retrieve Document Name - If Auto Retrieve is selected, the document name will be 
obtained from the application that sends the print command. No manual entry is 
allowed. Document names that exceed 24 characters are truncated.

– Document Name - When “Enter Document Name” is selected in the Retrieve 
Document Name list, a document name up to 24 alphanumeric characters.

• Sample Print - Sample Print outputs only one copy when multiple copies are specified. If 
there is no problem, the remaining sets can be printed. Select when you want to output 
sample prints.

Note
The Collated setting must be selected in the Page Setup tab when using Print Type.

• Delayed Print - Delayed Print temporarily stores print jobs in the printer, and then prints 
them at the scheduled time. Select when you want to output delayed prints.

See the On-line Help for details on the operation of the printer.

– Start Print Time - Specifies the time when a Delayed Print job will be printed. Place the 
cursor in the hour or minute box and press the up or down triangle to specify the start 
time. You can also set the time by entering the time directly into the boxes. The default 
setting is 00:00.

Paper Size

Select the paper size of the file to be printed.

Paper Source

Select the paper tray to be used for printing.

Paper Type

Select the paper type to be used for printing.
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2-sided Print

Performs 2-sided printing. Select either "Flip on long edge" or "Flip on short edge" for 2-sided 
printing. Select any one of these options as required. In "Flip on long edge" and "Flip on short 
edge," the side 1 and side 2 images are printed such that when rotated with the long edge and 
short edge respectively as axis, they are pointing in the same direction.

Stapling

Select the stapling position. The stapling position specified is based on the printing data. If the 
stapling position is incorrect, refer to the PostScript Kit manual and adjust the Stapling setting 
accordingly. 

Note
Limitations for stapling mixed size output may apply. Stapling for mixed size output is not 
available in the following situations:

• When a setting other than "1 Up" is selected for "Multiple-Up" in the "Layout" tab 

• When a setting other than "Off" is selected for "Booklet Creation" in the "Layout" tab 

• When "Double Print" is set to "On" under "Details" in the "Detailed Settings" tab

• When a size other than "A3," "B4," "A4," "B5," "8.5 x 11 in.," "11 x 17 in.," "16K (267 x 
194mm) / 8K (267 x 388mm)," and "16K (270 x 195mm) / 8K (270 x 390mm)" is selected

• When a setting other than "None" or "On (Mixed Sizes)" is selected for "Hole Punching" in 
the "Paper / Output" tab

Hole Punching

Select the punching position. The holes are made based on the output orientation of the 
paper. As a result, the holes may not be punched correctly depending on the position of the 
image.

Note
Moreover, there are limitations for punching holes on mixed size output. Hole punching for 
mixed size output is not available in the following situations:

• When a setting other than "1 Up" is selected for "Multiple-Up" in the "Layout" tab 

• When a setting other than "Off" is selected for "Booklet Creation" in the "Layout" tab 

• When "Double Print" is set to "On" under "Details" in the "Detailed Settings" tab 

• When a size other than "A3," "B4," "A4," "B5," "8.5 x 11 in.," "11 x 17 in.," "16K (267 x 
194mm) / 8K (267 x 388mm)," and "16K (270 x 195mm) / 8K (270 x 390mm)" is selected

• When a setting other than "None," "1 Staple (Mixed Sizes)," or "2 Staples (Mixed Sizes)" is 
selected for "Stapling" in the "Paper / Output" tab

Hole Punching - Specify the number of holes to punch. Select from Use Printer Settings, 2 
Holes, or 4 Holes.

Note
If 3 Holes is selected for Hole Puncher Setup on the Device Settings tab, only Use Printer 
Settings will be available for selection. Device Settings tab is displayed on the print driver 
screen when Properties is selected from the menu of the printer icon in the Printers folder.
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Stapling/Hole Punching for Mixed Size Output

Click this button to display the Stapling/Hole Punching for Mixed Size Output dialog box. You 
can specify the settings for stapling or punching for mixed sized documents.

Note
There are limitations for stapling mixed size output. Stapling for mixed size output is not 
available in the following situations:

• When a setting other than 1 Up is selected for Multiple-Up in the Layout tab 

• When a setting other than Off is selected for Print Booklet in the Layout tab 

• When Double Print is set to On under Details in the Detailed Settings tab 

• When a size other than "A3," "B4," "A4," "B5," "8.5 x 11 in.," "11 x 17 in.," "16K (267 x 
194mm) / 8K (267 x 388mm)," and "16K (270 x 195mm) / 8K (270 x 390mm)" is selected

• When a setting other than None or On (Mixed Sizes) is selected for Hole Punching in the 
Paper / Output tab 

• When a setting other than None, 1 Staple (Mixed Sizes), or 2 Staples (Mixed Sizes) is 
selected for Stapling in the Paper / Output tab

– Stapling - Specify the position to staple mixed size originals. Select 1 Staple (Mixed 
Sizes) or 2 Staples (Mixed Sizes).

Key Point
If Double Print is set to On under Details in the Detailed Settings tab, the Stapling feature 
will not be available. 

– Hole Punching - Select On (Mixed Sizes) to enable hole punching feature for mixed 
size originals.

Key Point
When Double Print is set to On under Details in the Detailed Settings tab, Hole Punching 
feature will not be available.

– Hole Punching - Specify the number of holes to punch. Select from Use Printer 
Settings, 2 Holes or 4 Holes.

Note
If 3 Holes is selected in Hole Punching Settings on the Device Settings tab, only Use Printer 
Settings will be available for selection.

Folding (Z Folding)

If Tri-Fold Output Tray is installed, select the check box to perform Z folding for Mixed Size 
Documents.

• Image Rotation (180deg) - Turn the mixed size originals by 180 degrees and print. 

• Select Portrait, Landscape, or Portrait & Landscape (For envelopes).

• If 2 Up or more is selected in Multiple-Up on the Layout tab, individual pages will be 
rotated and printed. 

• First Page - Specifies the Paper Size and Image Orientation of the first page of the mixed 
size document.

– Paper Size (First Page) - Specifies the paper size of the first page of the document.

The paper size combinations for mixed size originals are "A3 and A4," "B4 and B5," "8.5 
x 11 in. and 11 x 17 in. and "16K and 8K." Paper Size of the Mixed Pages will 
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automatically be specified based on this setting.

– Image Orientation (First Page) - Specifies the image orientation of the first page of 
the document.

Select either Portrait or Landscape.
• Mixed Pages - Specifies the Paper Size and Image Orientation of the mixed pages.

– Paper Size (Mixed Pages) - Displays the paper size of the mixed pages.

The paper size will automatically be specified based on the Paper Size settings of the 
first page.

– Image Orientation (Mixed Pages) - Specifies the image orientation of the mixed 
pages.

Select either Portrait or Landscape.

Folding

Select the folding method.

Note
"Z Fold”, "Z Tri-Fold," and "C Tri-Fold" will be available when the Tri-Fold Output Tray is installed 
and set up in the Device Settings tab.

Note
Bi-Fold is available when a Booklet Tray is installed and set up in the Device Settings tab.

Output Destination

Select the paper output destination. Select Auto Select or Finisher Tray (Large Output) from 
the Output Destination menu.

Printer Status

Open the Web browser and connect to CentreWare Internet Services for the printer to display 
the printer status.

To use CentreWare Internet Services, you must set the Internet Services on the printer to Start.
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Layout tab

Note
You can restore defaults by clicking Restore Defaults.

Settings:

Multi-Up

Prints 2, 4, 6, 9 or 16 consecutive pages of the document on a single page of paper. This feature 
is known as Multiple-Up.

Select the number of pages to be printed on a single page from "2 Up," "4 Up," "6 Up," "9 Up," 
and "16 Up." The area of the paper to be printed is divided equally among the pages and the 
pages will be automatically rotated and reduced to fit into the page.

Key Point
If setting other than Off is selected in Booklet Creation on the Layout tab, only 1 Up can 
be selected. You can check the result of the change in setting on the preview image at the 
top right of the screen.

Image Border

Select this check box to add a border around every page of the original document when printed 
in Multiple-Up layout.

Print Booklet

Specify the assembling and finishing methods for booklet creation. You can check the result of 
the change in setting on the preview image at the top right of the screen.

Key Point
Booklet Creation feature will only be available if Automatically Select or Auto Paper 
Select (Type) is selected in Paper Source on the Paper / Output tab.

Output Size for Booklet
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Specify the output size for booklet creation printing.

Note
When Booklet Creation is selected, only AutoSelect Tray and Auto Paper Select (Type) are 
available in Paper Source on the Paper / Output tab. Conversely, Booklet Creation feature is 
only available when Automatically Select or Auto Paper Select (Type) is selected in Paper 
Source.

Booklet Subsets

Specify the number of sheets in each subset when printing booklet in subsets. Select from 
None, or Every Sheet to Every 20 Sheets.

Gutter

Select this box to add a Gutter Margin.

Margin Shift

Clicking this button displays the Margins dialog box. Enter the position and the extent of the 
margin shift on the paper.

• Position - Specifies the margin shift (binding margin) position. The margin can be added 
to the left, right, top, or bottom of the paper. The margin positions change according to the 
paper orientation.

Key Point
If setting other than Off is selected in Print Booklet on the Layout tab, only No Shift will 
be available in Position.

• Side 1 - Specifies the margin on side 1 of the paper when using the Margin Shift 
function. You can specify any value between 0 and 50 mm in units of 1mm using the 
keyboard or the up and down arrows.

• Side 2 - Specifies the margin on side 2 of the paper when using the Margin Shift function 
in 2-sided printing.

– The margin shift position for side 2 is automatically set so that the margin is added to 
the same edge as side 1.

– You can specify any value between 0 and 50 mm in units of 1mm using the keyboard 
or the up and down arrows.

Printer Status

Open a Web browser and connect to CentreWare Internet Services for the printer to display the 
printer status.

To use CentreWare Internet Services, you must set the Internet Services on the printer to Start.

Note
This feature cannot be used when the printer is used as a local printer.
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2Macintosh computers

Tip
The User Interface (UI) screens shown in this guide may or may not reflect the screens 
displayed on your 4112/4127 system. The UI screens vary from system to system and from 
marketplace to marketplace. Therefore, the UI screens in this guide are a representation of the 
type of screens that may be seen on your particular system.

About the software
This section describes the Macintosh software that is included on the PostScript Driver Library 
CD-ROM.

Note
When using AppleTalk protocol to print from Macintosh, set the EtherTalk port to Enable on the 
Control Panel.

Bundled software

Insert the CD-ROM and double-click the Adobe icon to display the window. The following items 
are contained in the folder:

AdobePS Printer Driver (ver. 8.5.1, 8.7.0, and 8.8) and PPD files

Adobe PostScript driver and PPD files (for Macintosh).

Xerox PPD Installer

The PPD file installer for Mac OS X, 10.3.

Xerox PS Utility

Enables you to define your printer settings.

Adobe Screen Fonts

Contains 117 PostScript fonts and 19 TrueType fonts, which are standard for PostScript 3 
printers. In addition, 37 PostScript fonts for the Central European (CE) character set are 
included.

ATM (Adobe Type Manager) (ver. 4.5.2)

Helps you to install typefaces and activate and manage your fonts.
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Adobe Acrobat Reader

Allows you to view and print PDF files on all major computing platforms.

Readme.txt

Contains cautionary notes about how to use the printer driver. Ensure you read this before use.

Hardware/software requirements
The minimum system requirements for the Macintosh printer driver and the utility are described 
below.

Computer system
• Macintosh

• Power Macintosh

Basic software
• For PPD Installer - Mac OS X 10.3.3 or later

• For Xerox PS Utility - Mac OS 10.3 or later

Note
When using Mac OS X, launch the Classic environment to run the applications.

AdobePS Printer Driver 
Tip
When installing the printer driver, ensure that you select the correct one (4112/4127).

There are two steps to install the printer driver. Firstly, use the installer enclosed on the CD-ROM 
to install the printer to the Macintosh. Then, configure the printer driver according to the printer 
used.
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Installation procedure (Mac OS X)

Use the following procedure to install the PostScript Printer Description (PPD) file for your 
Macintosh computer. The Mac OS (operating system) X version 10.3.x is used as the example 
throughout this procedure.

Note
The printer driver does not need to be installed on the Mac OS X. It uses the Adobe PostScript 
driver that is provided with the operating system.

1. Insert the PostScript Driver Library CD-ROM in the CD-ROM drive. The PS icon appears on 
the desktop.

2. Double-click PS. The PS window opens.
3. Open the Mac folder.
4. Open the Mac OS X folder. The Mac OS X window opens. 
5. Double-click Xerox PPD Installer. The installer starts and the Authenticate window opens.
6. Enter the Administrator user name and password, then click OK.

The License screen opens.

7. Read through the license agreement carefully and, if you have no objections to it, click 
Accept.
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8. Confirm the Install Location and change it if necessary, then click Install.

9. Click Quit.

This completes the installation.

Proceed to “Adding a Printer (Mac OS X)” to continue.

Adding a Printer (Mac OS X)

After the PPD file has been installed, set the PPD file for the printer driver and then add the 
printer. The printer driver controls the printer functions based on the information in the PPD 
file. Use the following procedure to add a printer. This procedure uses Macintosh OS X v10.2.8 
as its example.

Note
Menu items and procedures may vary slightly for Mac OS X v10.3.3 or other operating system 
versions.

1. Check that the port on the Xerox 4112/4127 Copier / Printer is set to Enable.
• When using AppleTalk, set the EtherTalk port to Enable.

• When using IP Printing, set the LPD port to Enable.

You can check the EtherTalk and LPD settings in the System Settings List. See the User 
Guide for details about how to print the “System Settings List.”

2. Start [Print Center].

Note
You can find Print Center in the Utilities folder in the Applications folder. For Mac OS X 
10.3.3, open the Printer Setup Utility in the Utilities folder in the Applications folder.

The Printer List screen opens.
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3. Click Add.

4. Select the protocol used to connect the printer.

When using Apple Talk
5. Select Apple Talk from the menu, and specify the zone for the printer being used.

6. Select the printer you are using from the list.
7. Select Auto Select from Printer Model.
8. Click Add.

After clicking Add, a message may appear telling you that multiple printer files were found. 
Select the PPD file you will use and click Add.

When using IP Printing
9. Select IP Printing from the menu, and enter the IP address for the printer being used in 

Printer’s Address.

Note
For Mac OS X v10.3.3, select LPD/LPR for printer type.. 

10. Select Xerox 4112/4127 PS from Printer Model, and select the printer to be used.
11. Click Add.
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Printer options
1. Click Printers on the Print Center menu bar, and select Show Info, or

For Mac OS X v10.3.3, click [Printers] on the Printer Setup Utility menu bar, then select Show 
Info.

2. Select Installable Options, and select the options that have been installed on the printer. 
See “Printer options” on page 6. for details about the options.

Note
This section describes the Configure dialog in the Chooser and the Printer Specific Options of 
the printer driver.

For Mac OS X
1. Click Printers on the Print Center menu bar, and select Show Info.

For Mac OS X v10.3.3, click [Printers] on the Printer Setup Utility menu bar, then select 
Show Info.

2. Select Installable Options, and select the options that have been installed on the printer. 

Settings:

Hole Puncher Setup

Specify the number of holes to punch on the paper. Select from "2 Holes/4 Holes" or "3 Holes."

High Capacity Feeder

Select "Available" if the High Capacity Feeder has been installed.

Tri-Folding Output Tray

Select "Available" if the Tri-Fold Output Tray is installed.

Booklet Output Tray

Select "Available" if the Booklet Tray is installed.

Memory

The built-in memory is 512MB.
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Paper Size Settings

Specify the paper size group for different locales to enable the selection of paper sizes common 
to that locale. The following groups of paper size categorized by locale are available: "AB 
Series," "AB Series (8K/16K)," "AB Series (8 x 13")," "AB Series (8 x 13"/8 x 14")," and "Inch 
Series." As the paper size settings will be set automatically in accordance with the relevant 
locale, it is usually not necessary to change this setting.

Switch Paper Size (8K/16K)

Indicate your language preference to enable the set of 8K and 16K paper sizes that is best 
suited to your needs. If you select "Traditional Chinese," the dimensions of the 8K and 16K 
paper sizes are 267 x 388mm and 194 x 267mm respectively. If you select "Simplified Chinese," 
the dimensions will be 270 x 390mm and 195 x 270mm respectively.

Note
If "AB Series (8K/16K)" is not selected in "Paper Size Settings," both sets of 8K and 16K paper 
sizes will not be available despite the setting specified here.

Printer features

For Mac OS X

1. On the File menu of the current application, click Print.
The Print dialog box appears.

2. Select Printer Features.
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3. Specify the functions that you want to set.

Settings:

The settings that can be selected vary depending on which options have been installed. Make 
these settings after specifying the installed options in Configure. See “Printer Options”.

Offset Stacking

The position of individual jobs or sets of copies are shifted to either side of the output tray to 
enable easy separation.

Collated

Selects whether to collate a multiple-page file per set when they are printed.

Feed Separators from

Specifies the paper tray that transparency dividers are to be fed from. When [Auto] is selected, 
the tray set on the machine is used as the feed destination.

Print on Separators

Specifies whether or not to print on the transparency dividers as well as the transparency.

Front Cover

Specify whether to add front cover to the printouts. Select the paper tray for feeding the 
front cover sheets.

Back Cover

Specify whether to add back cover to the printouts. Select the paper tray for feeding the 
back cover sheets.

Tray 8 - Specify Tab Stock

Specifies whether tab stock is being loaded in tray 8. Select either "Plain" or "Tab Stock."

Stapling

Specifies whether or not to staple printed documents and the position of the staple. You can 
staple 2 to 50 sheets of 80 gsm or lighter paper.
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Hole Punching

Select the punching position. The holes are made based on the output orientation of the 
paper. As a result, the holes may not be punched correctly depending on the position of the 
image.

Hole Punching

Specify the number of holes to punch. Select from "Use Printer Settings," "2 Holes," or "4 
Holes." If "3 Holes" is selected for "Hole Puncher Setup," only "Use Printer Settings" will be 
available for selection.

Folding

Select the folding method.

Double Print

Enable this feature to repeatedly print one page twice on a paper with a bigger size than the 
original. You can use Double Print feature if you have set the zoom ratio to 100% with the 
following paper size and output size settings.

• Paper Size

• Output Size

• A4

• A3

• A5

• A4

• B5

• B4

• Folio (8.5 x 11 in.)

• Ledger (11 x 17 in.)

Booklet Creation

Specify the assembling and finishing methods for booklet creation. You can check the result of 
the change in setting on the preview image at the top right of the screen.

Output Size for Booklet Creation

Specify the output size for booklet creation printing.

Booklet Subsets

Specify the number of sheets in each subset when printing booklet in subsets. Select from 
"None," or "Every Sheet" to "Every 20 Sheets."

Skip Blank Pages

Specify whether to skip blank pages when printing documents that consist of blank pages.

Bypass Feed Orientation

Specifies the paper orientation when printing from the bypass tray. When feeding the short 
edge of the paper first, select [Landscape]. When feeding the long edge of the paper, select 
[Portrait].
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Paper Type/Media

Select the paper type to be used for printing.

Output Destination

Select the paper output destination.

Print Mode

Specifies whether to give priority to the print speed or the image quality.

Halftone

Select the halftone settings for printing.

• Select Fine Dots for the small size halftone dot commonly used in PostScript.

• Select Thick Dots for coarser dots than the Fine Dots setting.

• Select Type 3 for the same halftone setting that is used in PCL.

Image Enhancement

Specifies whether or not to use the Image Enhancement function. Selecting On smooths out 
boundaries when printing. This reduces jagged edges by artificially increasing the resolution of 
the image. When printing a bitmapped image composed of coarse halftone dots, smooth color 
or grayscale gradation is impossible in certain situations. In this case, select Off.

Draft Mode

Specifies whether or not to reduce the amount of toner used when printing drafts. When On is 
selected, the overall printed page becomes lighter. This is best for printing documents when 
high print quality is not necessary.

Custom Paper Auto Orientation

Specifies whether or not to correct the orientation of the custom paper.

Substitute Tray

Specifies what action to take when the paper for the print size is not loaded in the machine.

• Use Printer Settings - Use the printer settings. The settings can be confirmed on the 
control panel.

• Display Message - Display paper supply messages on the control panel. Printing is 
impossible until paper is supplied.

• Use Nearest Size (Adjust to Fit) - Selects the nearest paper size and automatically adjusts 
the image size as necessary.

• Use Nearest Size (No Zoom) - Selects the nearest paper size and prints the same size as 
the image.

• Use Larger Size (Adjust to Fit) - Selects paper larger than the original and automatically 
adjusts the image size as necessary.

• Use Larger Size (No Zoom) - Selects paper larger than the original and prints the same size 
as the image.

• Feed from Bypass Tray - Feed from bypass tray.
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Print Mixed Size Originals

Controls the orientation of the second-side image when printing double-sided.

Job Type (Mac OS X only)
1. On the File menu of the current application, click Print.

The Print dialog box appears.

2. Select Job Type.

3. Specify the functions that you want to set.
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Settings:

Job Type

You can specify the print function for Secure Print, Sample Print, and Delayed Print.

• Secure Print temporarily stores print jobs in the printer, and then prints them when print 
instructions are received from the control panel.

• Sample Print outputs only one copy when multiple copies are specified. If there is no 
problem, the remaining sets can be printed.

• Delayed Print temporarily stores print jobs in the printer, and then prints them at the 
scheduled time.

To use the Secure Print or Sample Print feature, input the User ID and password for Print Type. 
The password entered appears as bullets ( ).

• Normal Print - Select when you do not want to output secure prints, sample prints, or 
delayed prints.

• Secure Print - Select when you want to output secure prints.

• Sample Print - Select when you want to output sample prints.

• Delayed Print - Select when you want to output delayed prints. 

See the Online Help for details on the operation of the printer.

User ID

Enter the User ID for Secure Print or Sample Print.

Password

Enter the password for Secure Print. Each digit entered appears as a bullet ( ).

Retrieve Document Name

Select the method for specifying the document name. If you have selected Auto Retrieve, the 
valid document name can be up to 24 alphanumeric characters.

Document Name

When "Enter Document Name" is selected in the Retrieve Document Name list, a document 
name up to 24 alphanumeric characters can be specified.

Start Print Time

Specifies the time when a Delayed Print job will be printed. Place the cursor in the hour or 
minute box and press the up or down triangle to specify the start time. You can also set the time 
by entering the time directly into the boxes. The default setting is 00:00.
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Job Accounting (Mac OS X only)
1. On the File menu of the current application, click [Print].

The Print dialog box appears.

2. Select Job Accounting.

3. Specify the functions that you want to set.
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Settings:

Account Mode

Specifies if all users or only System Administrators can change authentication related settings.

Detailed User Settings

Opens the Detailed User Settings dialog box used to set the authentication information.

Use Default User Details - The values set in this feature are used as the authentication 
parameters.

• Specify Job Owner Name - Select how to specify User ID.

• Job Owner Name - Enter a User ID.

• Password - Enter a Password that matches the User ID. The password entered appears as 
bullets ( ).

• Account ID - Enter an Account ID.

• Billing ID - Enter a User ID for Charge Print.

• Password - Enter a Password that matches the Billing ID. The password entered appears as 
bullets ( ).

• Prompt User for Settings - Select this feature to display the [Enter User Details] dialog box 
each time you start printing. The user is then required to enter authentication information 
such as their User ID.

• Display Previous User Details - Select the check box to store the user details entered in the 
[Enter User Details] dialog box, and display the details in the box as a default next time.

• Hide User ID - Select the check box to specify whether a user ID is to be displayed or 
hidden when it is entered.

• Hide Account ID - Select the check box to specify whether an account ID is to be displayed 
or hidden when it is entered.
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Installing screen fonts
Key Point
It is recommended that all other applications are closed before installing the fonts. If 
applications are not closed, a warning message appears between Step 5 and Step 6.

1. Start Macintosh and insert the PostScript Driver Library CD-ROM into the CD-ROM drive.
2. Double-click the PS icon followed by the Screen Font folder and then the PS3 Fonts 

Installer. The following window appears:

3. Click Continue.
The license agreement dialog appears.

4. Read through the agreement carefully and if you have no objections to it, click Accept.

The PS3FontsInstaller dialog box appears.
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5. You may select Easy Install or Custom Install.
• Easy Install - installs all the fonts provided in the Screen Font folder.

• Custom Install - installs the selected fonts only. Click on the triangle arrow beside the 
four categories of fonts to display the fonts in each category and then check the fonts 
to be installed. For example, the diagram below shows that Arial CE of the CE TrueType 
fonts is selected. 

A warning message will appear if you did not quit all other applications before performing 
the font installation.

6. Click Install.
• The installation of the fonts begins.

• After the installation, you have to restart your Macintosh before the fonts can be used.

• Store your CD-ROM in a safe place.
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3Barcode Settings

Key Point
The User Interface (UI) screens shown in this guide may or may not reflect the screens 
displayed on your 4112/4127 system. The UI screens vary from system to system and from 
marketplace to marketplace. Therefore, the UI screens in this guide are a representation of 
the type of screens that may be seen on your particular system.

About barcode settings
Note
This guide assumes that the operator has a basic knowledge of barcodes.

Font types and character sets

For the character set used to specify each barcode character, see Character set tables. See 
Barcode sizes for details about the size of printed barcode.

The table below lists compatible barcode types.

Barcode type PostScript font name Refer to the following table

JAN HitachiITHINJANH8-RG JAN Character Set Table 

Code 39 HitachiIT-C39H8 Code 39 Character Set Table 

NW7 HitachiITHINNW7H8-RG NW7 Character Set Table 

Code 128 HitachiITHINC128H8-RG Code 128 Character Set Table 

ITF (without bearer bar) HitachiITHINITFH8-RG
ITF (Interleaved 2 of 5)
Character Set Table ITF (with bearer bar) HitachiITHINITFB-RG

Customer Barcode HitachiITHINPOSTBC-RG Customer Barcode Character Set 
Table 

Font type PostScript font name

OCR B LetterPress M OCRBLetM
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Note
The printed barcode’s readability depends largely on factors such as the quality of paper 
used and performance of the barcode reader. Before using this product, we recommend 
you thoroughly test it under the conditions in which it will be used.

Sample program and output results

A program that prints a sample of each type of barcode and a PDF showing the output results is 
provided. Use these samples as a reference when printing barcodes.

• Location of sample program and output results in PDF

Located in the [manual] > [sample] folder on the PostScript Driver Library CD-ROM

• Sample program name

Sample.ps

• Output results PDF name

Sample.pdf

Character set tables

JAN character set table

The table below lists the character sets used when printing JAN barcode characters.

Character

Character set

Left side odd parity Left side even parity Right side even parity

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation

0 30 0 41 A 4B K

1 31 1 42 B 4C L

2 32 2 43 C 4D M

3 33 3 44 D 4E N

4 34 4 45 E 4F O

5 35 5 46 F 50 P

6 36 6 47 G 51 Q

7 37 7 48 H 52 R

8 38 8 49 I 53 S

9 39 9 4A J 54 T
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Code 39 character set table

The table below lists the character sets used when printing Code 39 barcode characters.

Left side 
guard bar

22 "

Right side 
guard bar

23 #

Center bar 21 !

Character

Character set

Character

Character set

Character

Character set

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation

$ 24 $ 8 38 8 M 4D M

% 25 % 9 39 9 N 4E N

* 2A * (SP) 20 SP O 4F O

+ 2B + A 41 A P 50 P

- 2D - B 42 B Q 51 Q

. 2E . C 43 C R 52 R

/ 2F / D 44 D S 53 S

0 30 0 E 45 E T 54 T

1 31 1 F 46 F U 55 U

2 32 2 G 47 G V 56 V

3 33 3 H 48 H W 57 W

4 34 4 I 49 I X 58 X

5 35 5 J 4A J Y 59 Y

6 36 6 K 4B K Z 5A Z

7 37 7 L 4C L (SP) 40 @

Character

Character set

Left side odd parity Left side even parity Right side even parity

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation
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NW7 character set table

The table below lists the character sets used when printing NW7 barcode characters.

Code 128 character set table

The table below lists the character sets used when printing Code 128 barcode characters.

Character

Character set

Character

Character set

Character

Character set

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation

$ 24 $ 0 30 0 A 41 A

+ 2B + 1 31 1 B 42 B

- 2D - 2 32 2 C 43 C

. 2E . 3 33 3 D 44 D

/ 2F / 4 34 4 A 61 a

5 35 5 B 62 b

6 36 6 C 63 c

7 37 7 D 64 d

8 38 8

9 39 9

: 3A :

Value
Character Character set

CODE A CODE B CODE C HEX notation ASCII notation

0 SP SP 00 20 SP

1 ! ! 01 21 !

2 " " 02 22 "

3 # # 03 23 #

4 $ $ 04 24 $

5 % % 05 25 %

6 & & 06 26 &

7 ' ' 07 27 '

8 ( ( 08 28 (

9 ) ) 09 29 )

10 * * 10 2A *

11 + + 11 2B +
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12 , , 12 2C ,

13 - - 13 2D -

14 . . 14 2E .

15 / / 15 2F /

16 0 0 16 30 0

17 1 1 17 31 1

18 2 2 18 32 2

19 3 3 19 33 3

20 4 4 20 34 4

21 5 5 21 35 5

22 6 6 22 36 6

23 7 7 23 37 7

24 8 8 24 38 8

25 9 9 25 39 9

26 : : 26 3A :

27 ; ; 27 3B ;

28 < < 28 3C <

29 = = 29 3D =

30 > > 30 3E >

31 ? ? 31 3F ?

32 @ @ 32 40 @

33 A A 33 41 A

34 B B 34 42 B

35 C C 35 43 C

36 D D 36 44 D

37 E E 37 45 E

38 F F 38 46 F

39 G G 39 47 G

40 H H 40 48 H

41 I I 41 49 I

42 J J 42 4A J

43 K K 43 4B K

Value
Character Character set

CODE A CODE B CODE C HEX notation ASCII notation
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44 L L 44 4C L

45 M M 45 4D M

46 N N 46 4E N

47 O O 47 4F O

48 P P 48 50 P

49 Q Q 49 51 Q

50 R R 50 52 R

51 S S 51 53 S

52 T T 52 54 T

53 U U 53 55 U

54 V V 54 56 V

55 W W 55 57 W

56 X X 56 58 X

57 Y Y 57 59 Y

58 Z Z 58 5A Z

59 [ [ 59 5B [

60 \ \ 60 5C \

61 ] ] 61 5D ]

62 ^ ^ 62 5E ^

63 _ _ 63 5F _

64 NUL ` 64 60 `

65 SOH a 65 61 a

66 STX b 66 62 b

67 ETX c 67 63 c

68 EOT d 68 64 d

69 ENQ e 69 65 e

70 ACK f 70 66 f

71 BEL g 71 67 g

72 BS h 72 68 h

73 HT I 73 69 I

74 LF j 74 6A j

75 VT k 75 6B k

Value
Character Character set

CODE A CODE B CODE C HEX notation ASCII notation
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76 FF l 76 6C l

77 CR m 77 6D m

78 SO n 78 6E n

79 SI o 79 6F o

80 DLE p 80 70 p

81 DC1 q 81 71 q

82 DC2 r 82 72 r

83 DC3 s 83 73 s

84 DC4 t 84 74 t

85 NAK u 85 75 u

86 SYN v 86 76 v

87 ETB w 87 77 w

88 CAN x 88 78 x

89 EM y 89 79 y

90 SUB z 90 7A z

91 ESC { 91 7B {

92 FS | 92 7C |

93 GS } 93 7D }

94 RS ~ 94 7E ~

95 US DEL 95 7F DEL

96 FNC 3 FNC 3 96 A1

97 FNC 2 FNC 2 97 A2

98 SHIFT SHIFT 98 A3

99 CODE C CODE C 99 A4

100 CODE B FNC 4 CODE B A5

101 FNC 4 CODE A CODE A A6

102 FNC 1 FNC 1 FNC 1 A7

103 START(CODE A) A8

104 START(CODE B) A9

105 START(CODE C) AA

106 STOP AB

Value
Character Character set

CODE A CODE B CODE C HEX notation ASCII notation
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ITF (Interleaved 2 of 5) character set table

The table below lists the character sets used when printing ITF barcode characters.

Character

Character set

Character

Character set

Character

Character set

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation

00 21 ! 30 3F ? 60 5D ]

01 22 " 31 40 @ 61 5E ^

02 23 # 32 41 A 62 5F _

03 24 $ 33 42 B 63 60 `

04 25 % 34 43 C 64 61 a

05 26 & 35 44 D 65 62 b

06 27 ' 36 45 E 66 63 c

07 28 ( 37 46 F 67 64 d

08 29 ) 38 47 G 68 65 E

09 2A * 39 48 H 69 66 F

10 2B + 40 49 I 70 67 G

11 2C , 41 4A J 71 68 H

12 2D - 42 4B K 72 69 I

13 2E . 43 4C L 73 6A J

14 2F / 44 4D M 74 6B K

15 30 0 45 4E N 75 6C L

16 31 1 46 4F O 76 6D M

17 32 2 47 50 P 77 6E N

18 33 3 48 51 Q 78 6F O

19 34 4 49 52 R 79 70 P

20 35 5 50 53 S 80 71 Q

21 36 6 51 54 T 81 72 R

22 37 7 52 55 U 82 73 S

23 38 8 53 56 V 83 74 T

24 39 9 54 57 W 84 75 U

25 3A : 55 58 X 85 76 V

26 3B ; 56 59 Y 86 77 W

27 3C < 57 5A Z 87 78 X

28 3D = 58 5B [ 88 79 Y
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With ITF, one character set specifies the pair of a character denoted by a bar and a character 
denoted by a space. However, the START and the STOP character are specified by one character 
set.

Example:

To print the pair of characters of the bar representing “3” and the space representing “7,” 
specify “46” (HEX notation).

To print the pair of characters of the bar representing “7” and the space representing “3,” 
specify “6A” (HEX notation).

Customer barcode character set table

The table below lists the character sets used when printing customer barcode characters.

29 3E > 59 5C \ 89 7A Z

90 7B { 94 A1 DEL 98 A5

91 7C | 95 A2 99 A6

92 7D } 96 A3 START A7

93 7E ~ 97 A4 STOP A8

Character

Character set

Character

Character set

HEX 
notation

ASCII 
notation HEX notation ASCII notation

START 3C < CC1 61 a

STOP 3E > CC2 62 b

- 2D - CC3 63 c

0 30 0 CC4 64 d

1 31 1 CC5 65 e

2 32 2 CC6 65 f

3 33 3 CC7 67 g

4 34 4 CC8 68 h

5 35 5

6 36 6

7 37 7

8 38 8

Character

Character set

Character

Character set

Character

Character set

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation

HEX 
notation

ASCII 
notation
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Barcode sizes
The table below lists formulae for calculating the approximate dimensions of printed barcodes.

The dimensions of the barcode printed may vary, even when using the same program, 
depending on conditions such as the characteristics and resolution of the printer used, paper 
quality, and so forth. The dimensions derived from the formulae in this table are not guaranteed 
to be the actual dimensions of the printed barcodes. Use this table as a reference when 
estimating the size of printed barcodes.

9 39 9

Barcodes

type

Formula

Width Height

JAN (standard) P × 0.502 P × 0.352

Side margins not included. Indicates the height of 
the guard bar.

JAN (short version) P × 0.354 P × 0.352

Side margins not included. Indicates the height of 
the guard bar.

Code 39 P × (C + 2) × 0.106 P × 0.352

Inter character gap of the left and right sides 
not included.
“C” includes the checkdigit.

NW7 P × (C1 × 0.132 + C2 × 0.148 − 0.026) P × 0.352

Inter character gap of the left and right sides 
not included.
“C1” and “C2” include the checkdigit.

Code 128 P × (C × 0.081 + 0.096) P × 0.352

Formula for CODE C.

ITF
(without bearer bar)

P × ((C/2 × 0.175) +0.093) P × 0.352

Quiet zone not included.
“C” includes the checkdigit.

ITF
(with bearer bar)

P × ((C/2 × 0.137) + 0.323) P × 0.352

Bearer bar and quiet zone included.
“C” includes the checkdigit.

Bearer bar included.

Character

Character set

Character

Character set

HEX 
notation

ASCII 
notation HEX notation ASCII notation
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P: Font size (point)

C: Number of characters

C1: Number of characters (0,1,2,3,4,5,6,7,8,9,-,$)

C2: Number of characters (:,/,.,+,A,B,C,D)

Customer Barcode P × 7.297 P × 0.342

Spaces before the black bar of START code 
and after the black bar of the STOP code are 
not included.

Indicates the height of 
the long bar.

Barcodes

type

Formula

Width Height
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AAppendix

Cautions and limitations

About the driver

Cautions and limitations relating to each type of driver are listed in the Readme.txt file in the 
PostScript Driver Library CD-ROM. Ensure you read it before installing the driver.

Troubleshooting

See the User Guide for error codes and error messages displayed on the control panel and how 
to deal with paper jams.

Print operation

The printer driver allows you to make selections to print on custom paper and postcards using 
duplex and/or the stapling feature to the Finisher Tray. However, if you are printing on custom 
paper or postcards, these features will not function even though you may still be able to select 
them.

You can feed custom paper from the bypass tray only. However, when you select custom paper, 
the Paper Source selection does not change to Manual Feed automatically. Please select 
Manual Feed yourself.
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